CBP Polygraph TES-C Pre-Test Outline
1. Polygraph Examination Identification Data:
• Access Lafayette: Select File → New PF → Create New PF
• PF Name: Year (2-digits) – Assessment Number – Examinee’s Name in all CAPS:
Example: 17-0000 (SMITH)
• Select → Audio/Video → Record
• Record the Polygraph Examination Identification Data: Examiner’s Name, date, time,
Assessment Number, Examinee’s Name, Type of Exam, and location of the exam.
• Select → Audio/Video → Stop to stop the audio recording.
• Select → Audio/Video → Record again, when the examinee is in the polygraph suite.
Stop audio recordings on breaks and restart when back in the room.
2. Introduction
• My Name is ______________. I am a polygraph examiner with Customs and Border
Protection.
• Ask the examinee for their Driver’s License or other form of picture identification, to
verify their identity? Note: The Personal History section of Lafayette asks for Driver’s
License Number, State, and Expiration data.
• Purpose: I will be administering your polygraph examination regarding your
application for employment with CBP.
• Inform the examinee that the polygraph interview will be audio recorded.
3. Overview
• First, we will review and complete the Polygraph Examination Consent form.
• I will collect Medical Information to ensure you are medically suitable to undergo a
polygraph examination.
• Then, I will collect some basic background information.
• Next, I will explain the Polygraph Components.
• How polygraph works (Fight, Flight, Freeze).
• Then we will conduct a practice or Acquaintance Test (ACQT).
• After the practice test we will have a scheduled break.
• After the break, we will discuss the questions for your polygraph examination.
• The polygraph examination will consist of Security and two types of Diagnostic
questions (one group may be more difficult [first step in DLC conditioning]).
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• Then we will conduct your polygraph examination and discuss the results.
4. Polygraph Consent Form: Complete the Polygraph Consent Form (Topaz Signature Pad
• Examinee signs using the signature pad and the examiner signs using their PIV Card.
5. Opening Statement
• There are two primary parts to your Polygraph Examination
1. Discussion of the test issues
2. Recording your physiology
• To be successful in this process you must do two things…
1. If you do not understand anything I say, it is your responsibility to ask questions
until the matter is clear. You must ensure you understand everything I say, so that
you can answer completely and follow my instructions.
2. It is your responsibility to be thorough and accurate in your answers to the Security
questions. Do not leave matters out because they seem unimportant. If you do not
recall something, or do not want to answer something, just say so. You must be
100% confident of the accuracy of all your statements.
• It is my responsibility to tell you what you need to know to complete the test
successfully. I promise I will do that.
• Can I count on you to be completely straightforward and truthful in all your statements
today? Note: Observe Subject’s behavior throughout the opening statement.
• People with good intentions make promises, but people with good character and
integrity “keep them”.
6. Countermeasure Statement
• Tell me what you know about Polygraph.
• Have you conducted any research on Polygraph?
• If the examinee answers “No”, let the examinee know that most information on the
Internet is opinion based and often incorrect and misleading.
• Tell the examinee that they should NOT do anything to alter their polygraph
examination.
• If the examinee says “Yes”, they have conducted polygraph research, ask them what
information did they learn and where did they get the information.
• Again, tell the examinee that “most information on the Internet is incorrect and
misleading.”
• Inform the examinee that they should NOT do anything to alter their polygraph
examination.
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7. Review the Polygraph Data Sheet
• Before doing any polygraph testing, I need to assess your fitness to undergo polygraph
testing today.
• How would you describe your health today?
• Review and complete the Polygraph Data Sheet to determine if the examinee is suitable
for polygraph testing.
8. Review the Screening Interview Worksheet
• Review the Screening Interview Worksheet.
• Lay the foundation for the Integrity/Character Probable-Lie Comparison (PLC)
questions during the completion of this worksheet.
9. Countermeasures Statement
• Tell me what you know about Polygraph.
• Have you conducted any research on Polygraph?
• If the examinee answers “No”, let the examinee know that most information on the
Internet is incorrect and misleading.
• Tell the examinee that they should NOT do anything to alter their polygraph
examination.
• If the examinee says “Yes”, they have conducted polygraph research, ask them what
sites did they visit and what information did they learn.
• Again, tell the examinee that “most polygraph information on the Internet is incorrect
and misleading.”
• Inform the examinee that they should NOT do anything to alter their polygraph
examination.
• Ask the examinee to give you their word that they will not do anything to alter the
exam.
10. Explain the Polygraph Components
• Two Pneumograph Tubes: The pneumograph tubes are used to record physiological
data in the chest and lower abdomen area.
• Finger Plates (EDA): The finger plates are used to record sweat gland activity
produced by the fingers.
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• Cardio Cuff: Used to record blood volume and pulse rate. Take a minute to discuss the
Cardio Cuff. Example: During the polygraph examination, the cardio cuff will be
inflated and will stay inflated during the collection of each chart. As a result,
sometimes you may feel tingling in your arm. This is common and simply means the
cuff is properly placed on their arm. At the completion of the each chart, I will release
the pressure and allow you to move your arm.
• Seat/Foot Sensor Pads: Designed to record movements, so please remain still during
the polygraph test.
• All of these components are used to record very specific autonomic or automatic
physiological changes that may occur during the polygraph examination.
11. Fight, Flight, Freeze [F(3)]
• Polygraph works based on the Fight, Flight, or Freeze (F[3]) concept.
• When faced with a threat, people either Fight, Flight (Flee), or Freeze.
• In addition, the human body makes very specific changes to address the threat.
• These include changes in sweat gland activity, pulse rate, and other physiological
activity.
• An example of a Fight, Flight, or Freeze, is when we see a Police Officer running radar
and we are driving too fast.
• Our body make specific physiological changes to deal with a threat, i.e. getting a
speeding ticket.
• These same specific automatic physiological changes occur when people “Lie” and are
recorded using the polygraph instrument.
• The Polygraph cannot distinguish between “Big Lies”, “Little Lies”, or “Socially
Acceptable Lies”. A lie is a lie.
• You must be 100% honest to the Security Questions to successfully pass your
polygraph examination today.
12. Conduct the Practice or Acquaintance Test (ACQT)
• Have the examinee pick and write a number between 3 and 8 (not 3 or 8) on a piece of
paper, then have the examinee sit in the polygraph chair.
• Examiner: Write three numbers before and two after the number selected by the
examinee. Example: 2 – 3 – 4 – K5 – 6 – 7
• Place the paper on the wall in direct view of the examinee.
• Tell the examinee that the purpose of the Practice/ACQT is to:
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•
•
•
•

1. Gives the examinee the opportunity to become acquainted with the polygraph
process and see how the components feel.
2. Adjust the polygraph instrument to the examinee’s physiology.
3. Demonstrate your capability to respond when you lie.
4. Gives the examinee the opportunity to demonstrate that they can following the
examiner’s instructions.
Tell the examinee that you are going to place the components on the examinee and ask
them a series of questions regarding the numbers on the paper.
Have the examinee answer “No” to all questions on the Practice/ACQT, even on the
number they wrote.
Conduct the Practice/ACQT.
Sell the Practice/ACQT. Example: Let the examinee know that he/she had a
“significant” and “obvious” physiological response when they lied about the number
they wrote. Let the examinee know that based on the Practice/ACQT three things were
verified: (1) the polygraph instrument is perfectly adjusted to their physiology, (2)
polygraph works, and (3) polygraph works perfectly on the examinee.

13. Scope and Review the Examination Test Questions
• Review the Sacrifice Relevant question with the examinee. This question is introduced
as an “intent” question.
• If anything comes to mind when we are discussing the Security Questions today, it is
your responsibility to ask questions so that we can “discuss and clarify” any issues
before your polygraph.
• Scope TES-A Relevant Questions (Terrorism and Compromise of Classified
Information)
• Provide the Interview Route Maps (IRMs) to the examinee, while you scope each topic
using the Scoping Guide.
• The conversation should begin with “First, we are going to talk about Terrorism, please
give me your definition of Terrorism.” Then, you should provide the examinee with the
definition of the security topic you are scoping using the Scoping Guide.
• After scoping each security topic read the examinee the relevant question that will be
on the test.
• After you have completed TES-A security topics…
• Provide an “Appeal” for Serious Crimes. The “appeal” should generally address
Serious Crimes and Use/Transactional Involvement with Illegal Drugs.
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• If admissions are provided by the examinee, please note the date/year of the Serious
Crime, location(s) (City and State), and all other pertinent details. In addition,
admissions to drug usage should include (types of drugs used, how used, estimated
number of times, date/year, location [City and State], and all other pertinent details).
• Note: Serious Crimes and Transactional Illegal Drug Activity are pretested as
“Lifetime.” Illegal Possession and Use of Drugs is pretested “within the last 3 years.”
• Scope TES-B Relevant Questions (Serious Crimes and Hidden Foreign Contacts)
• Provide the Interview Route Maps (IRMs) to the examinee, while you scope each topic
using the Scoping Guide.
• The conversation should begin with “First, we are going to talk about Serious Crimes,
please give me your definition of Serious Crimes.” Then, you should provide the
examinee with the definition of the security topic you are scoping using the Scoping
Guide.
• After scoping each security topic read the examinee the relevant question that will be
on the test.
14. Introduce the Directed-Lie Comparison Questions (Diagnostic Lie and Diagnostic
Truth Questions)
• Now we are going to discuss the “Diagnostic Lie Questions” for you exam.
• Remember I said earlier that some questions may be harder for some people.
• Your exam will contain both “Diagnostic Lie and Diagnostic Truth Questions.”
• The Diagnostic Truth Questions should be very easy as you will only be required to be
truthful. However, the Diagnostic Lie questions may be more difficult, as you will be
required to deliberately lie to these questions called “Diagnostic Lie Questions” on your
exam.
• Earlier we conducted an Acquaintance Test using a set of numbers.
• During that test you clearly demonstrated the capability to respond when you lied.
• Sometimes, people can get tired, bored, fatigued or even lose focus.
• The “Diagnostic Lie” questions are used to ensure that you maintain the capability to
respond when you lie.
• It is critical that you pay attention. If you fail to remember to lie, or incorrectly answer
a “Diagnostic Lie” question on the test, you negate a critical part of your test.
• There will be two “Diagnostic Lie” questions on this test.
• These “Diagnostic Lie” questions will address minor transgressions, not affecting your
hiring status.
• A minor transgression is something minor that everyone has done wrong at least one
time in their life.
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• For the purposes of your test, I will read you the first “Diagnostic Lie” question, but I
do not want you to answer the question. Instead, I just want you to verify that you have
an event related to the “Diagnostic Lie” question, by saying “I have an event in mind”.
• Read the first “Diagnostic Lie” question to the examinee. Wait for the examinee to
reply that they have an event.
• Excellent. Now I will read you the “Diagnostic Lie” question again, just as it will
appear on the test and I want you to deliberately lie and say “No.”
• Read the “Diagnostic Lie” question to the examinee and have the examinee answer
“No”.
• Excellent. Now we will review the next “Diagnostic Lie” question.
• Again, this “Diagnostic Lie” question will address a minor transgression that everyone
has done at least one time in their life.
• For the purposes of your test, I will read you the second “Diagnostic Lie” question, but
again, I do not want you to answer the question. Instead, I just want you to verify that
you have an event related to the question, by saying “I have an event in mind”.
• Read the second “Diagnostic Lie” question to the examinee. Wait for the examinee to
reply that they have an event.
• Excellent. Now I will read you the “Diagnostic Lie” question again, just as it will
appear on the test and I want you to deliberately lie and say “No.”
• Read the “Diagnostic Lie” question to the examinee and have them answer “No”.
• Excellent. Those are the “Diagnostic Lie” questions on your test, please remember to
follow my instructions and deliberately lie to these questions on the test.
• Next, we will discuss the “Diagnostic Truth” questions.
• Transition to and introduce the “Diagnostic Truth” (Known Truth) questions.
15. Review all test questions
• Practice actual verbal responses.
• Instruct the examinee to answer exactly as s/he will on the exam.
• Answers MUST BE timely.
16. In-test Procedures
• Tell the examinee that the questions will not be in any specific order.
• Some questions will be repeated.
• Multiple charts and separate exams will be required.
• 20-30 second questions spacing.
• If an artifact occurs affecting two of the three tracings at relevant questions, collect a
complete the chart, then collect a Short Chart (X – I1 – I2 – SRQ – 3C1 – 4R1 – 4R2 –
3C2 or X – I1 – I2 – SRQ – 3C1 – 4R3 – 4R4 – 3C2)
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17. TEST DATA ANLYSIS
• The 7-position numerical evaluation scoring system is used for TES.
• Complete the examiner score sheet(s) in Lafayette.

18. No Significant Response (NSR) Post Test
• Before conducting the NSR Post Test, speak the current date and time for the audio
recording. Turn-off the audio recording, then turn-on the recording and again speak the
current date and time for the audio recording.
• Inform the examinee that you did not observe significant physiological responses to the
National Security or Suitability questions. However, responses were observed at the
integrity/character questions, but no further discussions on these questions will occur at
this time.
• Discuss the Quality Control Process: The entire polygraph examination will be
independently reviewed by senior polygraph examiners assigned CBP Quality Control
duties. They will either agree or disagree with my preliminary decision. If they
disagree with my preliminary, they may direct the conduct of additional polygraph
testing.
• If additional testing is directed by Quality Control personnel, ask the examinee if he/she
would you be willing to participate in additional polygraph testing.
• If the examinee answers “Yes”, ask the examinee if they would have any problem with
you conducting the examination. If the examinee answers “Yes”, they would have a
problem with you conducting their exam, simply tell the examinee that you will note
their response and have additional testing completed by another CBP polygraph
examiner.
• Ask the examinee if they were treated fairly and professionally during the interview
today?
• Recap any e-QIP updates to the examinee’s application and any admissions made by
the examinee during the polygraph interview. If admissions made by the examinee
could be disqualifying, obtain a statement.
• Speak the current date and time for the audio recording, then turn-off the audio
recordings to complete the polygraph examination.
19. Post Test When a No Opinion (NO) Decision is Assigned
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• Based on the test data analysis performed by the examiner, identify the relevant
question with the lowest numerical score. Inform the examinee that he/she exhibited
responses at (Enter the Security Topic[s] here). Use themes and elicitation techniques
in an effort to obtain information. If no additional information is obtained after about
15-30 minutes, prepare a new question list and conduct additional polygraph testing
using breakdown/breakout testing.
• At the conclusion of the examination, but before the wrap-up, speak the current date
and time for the audio recording. Turn-off the audio recording, then turn-on the
recording and again speak the current date and time for the audio recording.
• Inform the examinee of the preliminary examination results.
• Discuss the Quality Control Process: The entire polygraph examination will be
independently reviewed by senior polygraph examiners assigned CBP Quality Control
duties. They will either agree or disagree with my preliminary decision. If they
disagree with my preliminary, they may direct the conduct of additional polygraph
testing.
• If additional testing is directed by Quality Control personnel, ask the examinee if he/she
would you be willing to participate in additional polygraph testing.
• If the examinee answers “Yes”, ask the examinee if they would have any problem with
you conducting the examination. If the examinee answers “Yes”, they would have a
problem with you conducting their exam, simply tell the examinee that you will note
their response and have additional testing completed by another CBP polygraph
examiner.
• Ask the examinee if they were treated fairly and professionally during the interview
today?
• Recap any e-QIP updates to the examinee’s application and any admissions made by
the examinee during the polygraph interview. If admissions made by the examinee
could be disqualifying, obtain a statement.
• Speak the current date and time for the audio recording, then turn-off the audio
recordings to complete the polygraph examination.
20. Significant Response (SR) Post Test
• Inform the examinee that they failed the polygraph and begin using themes and
elicitation techniques to obtain information.
• If additional information is obtained, determine if additional breakdown/breakout
testing is required.
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• At the conclusion of the interview, speak the current date and time for the audio
recording. Turn-off the audio recording, then turn-on the recording and again speak the
current date and time for the audio recording.
• Inform the examinee of the results of the polygraph examination.
• Discuss the Quality Control Process: The entire polygraph examination will be
independently reviewed by senior polygraph examiners assigned CBP Quality Control
duties. They will either agree or disagree with my preliminary decision. If they
disagree with my preliminary, they may direct the conduct of additional polygraph
testing.
• If additional testing is directed by Quality Control personnel, ask the examinee if he/she
would you be willing to participate in additional polygraph testing.
• If the examinee answers “Yes”, ask the examinee if they would have any problem with
you conducting the examination. If the examinee answers “Yes”, they would have a
problem with you conducting their exam, simply tell the examinee that you will note
their response and have additional testing completed by another CBP polygraph
examiner.
• Ask the examinee if they were treated fairly and professionally during the interview
today?
• Recap any e-QIP updates to the examinee’s application and any admissions made by
the examinee during the polygraph interview. If admissions made by the examinee
could be disqualifying, obtain a statement.
• Speak the current date and time for the audio recording, then turn-off the audio
recordings to complete the polygraph examination.
21. Administrative Requirements
• Complete all entries in Lafayette CPS (Score sheets and Personal History Section).
• Email the exam to yourself for uploading into CAPS.
• Access CAPS and upload the Exam w/Audio Recordings, the Consent form, Polygraph
Background Questionnaire, and Statement into CAPS.
• Complete all CAPS entries and send to QC.
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